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Preface

Audience for This Guide
Welcome to Release 11i of the Oracle Quoting - Forms Implementation Guide, formerly 
the Oracle Order Capture Implementation Guide.

This guide assumes you have a working knowledge of the following:

� The principles and customary practices of your business area.

� Oracle Quoting

If you have never used Oracle Quoting, Oracle suggests you attend one or more 
of the Quoting training classes available through Oracle University.

� The Oracle Applications graphical user interface. 

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.

How To Use This Guide
This guide contains the information you need to understand and use Quoting.

� Chapter 1 provides an overview of the Quoting application and its components, 
and lists features and functionality new in this release.

� Chapter 2 describes Oracle Quoting’s architecture and lists the minimum 
software and hardware requirements.

� Chapter 3 lists the mandatory and conditional dependencies of Oracle Quoting.
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� Chapter 4 provides an overview of the implementation process.

� Chapter 5 lists the specific tasks involved in the implementation of Oracle 
Quoting.

� Chapter 6 contains a list of tasks for verifying the implementation.

� Appendix A contains a complete list of Oracle Quoting’s public APIs.

� Appendix B provides a list of the pricing and qualifier attributes that Oracle 
Quoting supports.

Typographic Conventions
The following table lists the typographic conventions used in this manual:

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/.

Convention Meaning

italic text Book titles

Courier text User commands and file content examples

UPPERCASE Structured Query Language (SQL) commands, initialization 
parameters, profile options, responsibilities, or environment 
variables

boldface text Menu, button, keyboard, and form options

Emphasized words or phrases

< > Angle brackets enclose user-supplied names.

Note: Do not type the angle brackets.



xi

Accessibility of Code Examples in Documentation JAWS, a Windows screen 
reader, may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, JAWS may not always read a line of text that 
consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation This 
documentation may contain links to Web sites of other companies or organizations 
that Oracle Corporation does not own or control. Oracle Corporation neither 
evaluates nor makes any representations regarding the accessibility of these Web 
sites.

Other Information Sources
You can choose from many sources of information, including online documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle Quoting.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). Online 
help patches are available on MetaLink.

Related Documentation
Quoting shares business and setup information with other Oracle Applications 
products. Therefore, you may want to refer to other product documentation when 
you set up and use Oracle Quoting.

You can read the documents online by choosing Library from the expandable menu 
on your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.
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Documents Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle Quoting (and any 
other Oracle Applications products). This guide also includes information on 
setting user profiles, as well as running and reviewing reports and concurrent 
processes.

You can access this user’s guide online by choosing ”Getting Started with Oracle 
Applications” from any Oracle Applications help file.

Documents Related to This Product

Oracle Quoting - Forms Concepts and Procedures
This document provides users with information on the general principles and 
procedures of creating and managing quotes in Oracle Quoting.

Implementing Oracle CRM: ERP Functional Checklist
This document provides users with a list of verification tasks to perform before 
using CRM applications.

Oracle Pricing User’s Guide
This document provides users with information on setting up promotion codes, 
pricing agreements, and price lists that are used when creating quotes in Oracle 
Quoting.

Oracle Bill of Materials User’s Guide
This user guide explains how to set up Oracle Bill of Materials, which Oracle 
Quoting uses to access information about components of products.

Oracle General Ledger User Guide
This document provides information on exchange rates, and setting up ledgers and 
books.

Oracle Inventory User’s Guide
This document provides users with information on setting up products in Oracle 
Inventory.
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Oracle Order Management Suite Implementation Manual
This manual explains the steps necessary to implement Oracle Order Management, 
which Oracle Quoting uses to transform quotes into orders. 

Oracle Receivables User’s Guide
This document provides users with setup information for Oracle Receivables as 
well as information about creating customers and setting up tax information.

Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications, 
the Oracle8 technology stack, and the Oracle8i Server technology stack by 
automating many of the required steps. This guide contains instructions for using 
Oracle Rapid Install and lists the tasks you need to perform to finish your 
installation. You should use this guide in conjunction with individual product 
user’s guides and implementation guides.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
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run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library components 
needed to implement the Oracle Applications user interface described in the Oracle 
Applications User Interface Standards for Forms-Based Products. It also provides 
information to help you build your custom Oracle Forms Developer 6i forms so that 
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.

Other Implementation Documentation

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Quoting implementation team, as well as for users responsible for the ongoing 
maintenance of Oracle Applications product data. This manual also provides 
information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on Metalink
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Oracle Applications Message Reference Manual
This manual describes Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.

Oracle CRM Application Foundation Implementation Guide
Many CRM products use components from CRM Application Foundation. Use this 
guide to correctly implement CRM Application Foundation.

Training and Support

Training
Oracle offers training courses to help you and your staff master Quoting and reach 
full productivity quickly. You have a choice of educational environments. You can 
attend courses offered by Oracle University at any one of our many Education 
Centers, you can arrange for our trainers to teach at your facility, or you can use 
Oracle Learning Network (OLN), Oracle University’s online education utility. In 
addition, Oracle training professionals can tailor standard courses or develop 
custom courses to meet your needs. For example, you may want to use your 
organization’s structure, terminology, and data as examples in a customized 
training session delivered at your own facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Quoting working for you. This 
team includes your Technical Representative, Account Manager, and Oracle’s large 
staff of consultants and support specialists with expertise in your business area, 
managing an Oracle8i server, and your hardware and software environment.

OracleMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Technical Libraries/ERP Applications/Applications Installation and 
Upgrade/Alerts.



xvi

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Technical Libraries/ERP 
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications 
data unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity 
of your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify 
Oracle Applications data using anything other than Oracle Applications, you 
may change a row in one table without making corresponding changes in 
related tables. If your tables get out of synchronization with each other, you risk 
retrieving erroneous information and you risk unpredictable results throughout 
Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability 
to track who has changed your information because SQL*Plus and other 
database tools do not keep a record of changes.

About Oracle
Oracle Corporation develops and markets an integrated line of software 
products for database management, applications development, decision 
support, and office automation, as well as Oracle Applications, an integrated 
suite of more than 160 software modules for financial management, supply 
chain management, manufacturing, project systems, human resources and 
customer relationship management.

Oracle products are available for mainframes, minicomputers, personal 
computers, network computers and personal digital assistants, allowing 
organizations to integrate different computers, different operating systems, 
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different networks, and even different database management systems, into a 
single, unified computing and information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.



xviii



Introduction 1-1

1
Introduction

This topic group provides an overview of the Oracle Quoting - Forms application 
and its components, and lists features and functionality new in this release.

� Oracle Quoting Overview

� Oracle Quoting Features

� New in this Release
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1.1 Oracle Quoting Overview
Quoting allows users to create and manage quotes as a negotiation tool and, on 
receipt of customer agreement, to submit the quote as an order. In addition to acting 
as a single point of entry into Oracle Order Management, Quoting is an integral part 
of the CRM sales cycle.

Quoting enables you to perform actions such as creating new customer records, 
versioning and approving quotes, converting quotes into orders, and verifying 
product availability. 

1.1.1 Oracle Quoting Features
Quoting provides you with the ability to:

� Create, modify, and delete quotes

� Configure items

� Price quotes

� Calculate taxes

� Check availability

� View customer and quote history

� View and modify orders

� Convert quotes to orders

1.2 New in this Release
Quoting contains the following new functionality in this release:

� Enhanced print quote functionality

� General Services Administration (GSA) Pricing

� Tax Exemption

� Security
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2
Technology, Requirements, and

Performance

This topic group contains an overview of the architecture and a description of the 
minimum software and hardware requirements of Oracle Quoting.

� Architectural Overview

� Minimum Software Requirements

� Minimum Hardware Requirements
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2.1 Architectural Overview
Oracle Applications run on a three-tiered framework known as Internet Computing 
Architecture. 

� The desktop tier provides the user interface display. In Internet Computing 
Architecture, only the presentation layer of the application is on this tier, in the 
form of a plug-in to a standard Internet browser.

� The middle tier, or application tier, manages Oracle applications and other 
tools.

� The database tier manages the Oracle8i database, which provides centralized 
storage and schema.

Quoting uses the Oracle Forms Server with web-deployed forms. The Forms Server 
mediates between the Forms Client, a java applet running on the desktop tier, and 
the Oracle8i database server on the back end. The Forms Server and Forms Client 
exchange messages across a standard network connection, which may use either 
TCP/IP or HTTP.

The Forms Client displays only Web-deployed forms and provides field-level 
validation, multiple coordinated windows, and data entry aides. A Java-enabled 
web browser manages downloads, startup, and execution of the Forms Client on 
the desktop.

Another software component on the middle tier, the HTTP Server, starts a client 
session over the internal or external Web. The HTTP Server in 11i is the Apache 
HTTP Server.

2.2 Minimum Software Requirements
The following table lists the minimum software requirements for Quoting.

Table 2–1 Minimum Software Requirements

Tier Software Required

Desktop tier Oracle JInitiator

Middle tier/application 
tier

Oracle Forms Server

Apache HTTP Server

Database tier Oracle8i Enterprise Edition (8.1.7)
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2.3 Minimum Hardware Requirements
The following table lists the minimum hardware requirements for Quoting.

Table 2–2 Minimum Hardware Requirements

Hardware Minimum required

CPU 2 CPUs minimum, but 4 or more recommended

Memory 256 MB, but 1GB recommended

Disk Space 22 GB
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3
Dependency Requirements and Verification

This topic group provides information on the applications and modules that 
integrate with Oracle Quoting.

� Mandatory Dependencies

� Conditional Dependencies

� Installation and Dependency Verification
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3.1 Mandatory Dependencies
Quoting requires that the following applications be installed and implemented.

� Oracle Receivables — Quoting obtains tax information and customer account 
information from Oracle Receivables. Refer to the Oracle Receivables User Guide 
for complete setup information.

� Oracle Advanced Pricing — Quoting uses Advanced Pricing to set up price 
lists, discounts, adjustments, and promotions. Refer to the Oracle Pricing User’s 
Guide for complete setup information.

� Oracle Bill of Materials — Quoting uses Bill of Materials to access information 
about the components associated with a product. Refer to the Bill of Materials 
User’s Guide for complete setup information.

� Oracle General Ledger — Quoting uses General Ledger to set up ledgers and 
books and store exchange rates. Refer to the Oracle General Ledger User Guide for 
complete setup information.

� Oracle Inventory — Quoting accesses the Availability to Promise (ATP) and 
reservation functions, and all item information from Inventory. Refer to the 
Oracle Inventory User’s Guide for complete setup information.

� Oracle Order Management — Quoting uses Order Management to create 
orders out of quotes. You must set up the default Item Validation Organization 
for your operating unit in Order Management. This can be done in the Order 
Management application Setup > Parameter menu. Refer to the Oracle Order 
Management Suite Implementation Manual for complete setup information.

3.2 Conditional Dependencies
The following conditional dependencies provide desired functionality but are not 
required for Quoting to function.

� Oracle Configurator — Quoting uses Configurator to configure model items. 
Refer to the Oracle Configurator Installation Guide and Oracle Configurator 
Implementation Guide for complete setup information.

� Oracle iPayment — Quoting calls iPayment for credit card authorizations. 
Refer to the Oracle iPayment Implementation Guide for complete setup 
information.

� Oracle Reports — Quoting uses Reports to develop its print quote reports. 
Refer to Oracle Reports Developer Getting Started for complete setup information.
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� Oracle Service Contracts — Quoting calls Oracle Service Contracts to access 
contract details for service items. Refer to the Oracle Contracts for Service 
Implementation Guide for complete setup information.

� Oracle Service Installed Base — Quoting accesses Service Installed Base for a 
list of all serviceable products and installation details. Refer to the Oracle Service 
Implementation Guide for complete setup information.

3.3 Installation and Dependency Verification
Please refer to the following documentation to ensure that all mandatory 
dependencies are installed and implemented correctly:

� ERP Functional Checklist

� Implementing Oracle CRM: Foundation Functional Checklist
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4
Implementation Overview

This document provides general descriptions of the setup and configuration tasks 
required to successfully implement Oracle Quoting. Topics include:

� Process Description

� Implementation Task Sequence
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4.1 Process Description
Sales representatives can use Quoting to create and manage quotes, and if approved 
by the customer, to transform those quotes into orders.

In order to effectively implement Quoting, you must perform the following tasks:

� Set up quote status

� Set lookup types

� Set system profile options

� Set up GSA Pricing

4.2 Implementation Task Sequence
In order to fully implement Quoting, you must perform the following steps:

1. Set up quote status and quote status transitions. 

Quoting is delivered with predefined quote statuses. You can define new quote 
statuses or modify the predefined statuses based on business needs. 

2. Set up lookup types.

You must identify and define lookup types based on your business needs.

3. Set up system profile options.

You must define system profile options, which affect the way Quoting looks 
and performs, to fit your business needs.

4. Define descriptive flexfields.

Descriptive flexfields are customizable, undefined fields on the Quoting form 
that the application developer can define as needed.

5. Set up print quote.

To use print quote, you must first designate a printer. Also, if you require 
personalized print quote reports, you must customize the report in Report 
Builder.

6. Set up GSA Pricing.

GSA is a customer classification that indicates that the customer is a U.S. 
government customer. If you want Quoting to detect GSA violations, you must 
set the necessary profile options.



Implementation Task Sequence

Implementation Overview 4-3

7. Create additional attachments document categories. Optional.

Quoting supports one document category, which defaults into the Category 
field when you create an attachment. You can create additional document 
categories as needed.
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5
Implementation Tasks

This topic group provides you with the steps necessary to implement Oracle 
Quoting.

� Setting Up Quote Status and Quote Status Transitions

� Setting Up Lookup Types

� Setting System Profile Options

� Defining Descriptive Flexfield Information

� Setting Up the Print Quote Functionality

� Setting up GSA (General Services Administration) Pricing

� Creating Additional Attachments Document Categories
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5.1 Setting Up Quote Status and Quote Status Transitions
Use this procedure to perform the following tasks:

� Add new quote statuses

� Set up quote versioning

� Enable or disable existing quote statuses

� Set up the allowable status changes, or transitions, for each status

The status of a quote indicates its progress from the initial offer until the order is 
placed. As sales representatives work on a quote, they indicate its progress by 
changing the status. Quote status tells others in their group how negotiations with 
the customer are progressing. Depending on how you define your quote statuses, it 
can also determine what kind of changes a sales representative can make to the 
quote.

The default quote statuses are automatically set when the product is installed. Your 
system administrator may change these statuses based on business needs. 

Quoting is delivered with predefined quote statuses. You can define new quote 
statuses or modify the predefined statuses based on business needs. Users need 
Quote Statuses to create quotes. Refer to Oracle Quoting - Forms Concepts and 
Procedures for an explanation of quote status.

Login
Log in to Oracle Forms.

Responsibility
To perform these tasks, you must be logged in with the Quoting Sales Manager 
responsibility.

Prerequisites
None

Steps
1. Navigate to the Quote Status Setup window.

Note: You cannot change or remove the statuses Drafted, Entered, 
or Ordered due to programmatic references.
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2. If you want to add a new quote status, then:

a. In the Quote Statuses region, select a blank entry line or a line below which 
you wish to insert the new entry.

b. Enter the status code. This is the internal name and is not to be seen by the 
user.

c. Enter the status name and status description. These are displayed in the list 
of values for users.

d. If you want the new status to create a version when the user updates and 
saves a quote, then check the Auto Versioning check box.

e. If you wish to enable a user to make changes to the quote, to add new quote 
lines or to modify prices, for instance, then check the Update Allowed 
check box.

f. If you wish to set time limits when this new status is available, then enter 
dates in the Effective From and Effective To fields.

g. Click Save on the toolbar.

3. If you wish to set up the rules that determine the permitted status transitions 
for a particular status, then:

a. In the Quote Statuses region, select the status you wish to set up.

b. In the Allowed Transition to Status region, use the Code LOV to select an 
allowable transition status. You can allow the status in the Quote Statuses 
region to transition to more than one status.

c. Repeat the previous step for each permitted transition status.

d. If you wish to disable an existing status, then uncheck the Enabled box.

e. Click Save on the toolbar.

5.2 Setting Up Lookup Types
Use the following list to identify the lookup types (Quick Codes) that you need to 
define for your specific implementation. You can enter them in any order.

Login
Log in to Oracle Forms.
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Responsibility
To perform this task, you must be logged in with the Quoting Sales Manager 
responsibility.

Prerequisites
None

Steps
1. Choose Quick Codes and click Open.

The Quoting Lookups window opens.

2. Choose View > Query by Example > Run.

The window will display all Quoting lookup types. Use the down arrow key to 
scroll through them.

3. Set the lookup types using the standard procedure outlined in the Oracle 
Applications User’s Guide. 

The following tables describes the lookup types used in the implementation of 
Quoting.

Table 5–1 Quoting Lookup Types

Lookup Type Description

ASO_CUSTOMER_TYPE Defines customer type for sold-to, bill-to, and 
ship-to customers.

ASO_DEFAULT_ORDER_STATE The default state of an order when the quote is 
passed to Oracle Order Management. The 
seeded values are Entered and Booked. Each 
triggers different Oracle Order Management 
validation.

ASO_DISCOUNTING_
PRIVILEGE

Discounting privilege for manual discounting.

ASO_EXT_VALUE_TYPE Data type of value for order line attribute. This 
lookup is used by an Quoting API for 
validation of VALUE_TYPE in ASO_QUOTE_
LINE_ATTRIBS_EXT.

ASO_FUNCTIONALITY CODE Functionality code to be used in User Hooks. 
Not used — reserved for future use.
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ASO_GSA_PRICING Determines the level of error message for GSA 
violation

ASO_HEADER_
RELATIONSHIP_TYPE

Type of header relationships between quote 
headers. There is one seeded value: Copy. This 
lookup is used by an Quoting API for 
validation of RELATIONSHIP_TYPE in ASO_
QUOTE_HEADER_RELATIONSHIPS.

ASO_ITEM_TYPE Item types for items which are added to the 
cart

ASO_LINE_ATTRIBUTE_
STATUS

Status of an order line attribute. This lookup is 
used by an Quoting API for validation of 
STATUS in ASO_QUOTE_LINE_ATTRIBS_
EXT.

ASO_LINE_ATTRIBUTE_TYPE Type of order line attribute. This lookup is used 
by an Quoting API for validation of 
ATTRIBUTE_TYPE_CODE in ASO_QUOTE_
LINE_ATTRIBS_EXT.

ASO_LINE_RELATIONSHIP_
TYPE

Type of line relationship. This lookup is used 
by an Quoting API for validation of 
RELATIONSHIP_TYPE in ASO_QUOTE_
LINE_RELATIONSHIPS.

ASO_OBJECT_RELATIONSHIP_
TYPE

Type of object relationship.This lookup is used 
by an Quoting API for validation of 
RELATIONSHIP_TYPE_CODE in ASO_
QUOTE_RELATED_OBJECTS.

ASO_OM_ACCESS_PRIVILEGE Determines mode of access to the Oracle Order 
Management form via the Customer History 
form

ASO_ORDER_FEEDBACK_
CRM_APPS

CRM applications registered for order 
feedback. All applications listed here are 
informed of any changes to an order in Oracle 
Order Management.

ASO_PARTY_OBJECT_TYPE Type of Party object (e.g. Contact Points) 
related to the Quote object.This lookup is used 
by an Quoting API for validation of PARTY_
OBJECT_TYPE in ASO_QUOTE_PARTY.

Table 5–1 Quoting Lookup Types

Lookup Type Description
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ASO_PARTY_TYPE Type of party (Quote_to, Deliver_To). This 
lookup is used by an Quoting API for 
validation of PARTY_TYPE in ASO_QUOTE_
PARTY.

ASO_PAYMENT_OPTION Payment options available to users. Not used 
— reserved for future use.

ASO_PAYMENT_TYPE Payment types available to users

ASO_QUOTE_LINE_ATTRIBS_
EXT

Name of an order line attribute. This lookup is 
used by an Quoting API for validation of 
NAME in ASO_QUOTE_LINE_ATTRIBS_EXT.

ASO_QUOTE_OBJECT_TYPE Type of object (quote header identifier). This 
lookup is used by an Quoting API for 
validation of QUOTE_OBJECT_TYPE_CODE 
in ASO_QUOTE_OBJECT_RELATIONSHIPS.

ASO_QUOTE_PARTIES Seeded lookup data required for migration in 
Sales

ASO_QUOTE_SOURCE The source of the quote

ASO_RELATED_OBJECT_TYPE Type of object (Contracts, Opportunity, Order) 
related to the quote.This lookup is used to 
validate OBJECT_TYPE_CODE in ASO_
QUOTE_RELATED_OBJECTS. Lookup code 
OPPORTUNITY has been made obsolete in 
ASO Patchset G. Instead LDID will be used to 
relate an object of type "Opportunity" to a 
quote.

ASO_RESERVATION_TYPE Lookup values for Profile Option to decide at 
what level Reservation needs to be done.

ASO_SERVICE_TYPE Service reference type code. A service must 
always be linked to an item or an item in the 
customer installed base. This list of values 
specifies where the item is. Seeded values 
include: Quote, Order, and Customer Product.

Table 5–2 Obsolete Quoting Lookup Types

Lookup Type Description

ASO_CONTACT_PROFILE_
TYPE

Profile type of a customer contact

Table 5–1 Quoting Lookup Types

Lookup Type Description
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5.3 Setting System Profile Options
Use the following list to identify the profile options that you need to set for your 
specific implementation. You can set these profile options in any order you like.

Login
Log in to Oracle Forms.

Responsibility
To perform this task, you must be logged in with the System Administrator 
responsibility.

Prerequisites
None.

Steps
1. Navigate to Profile > System.

The Find System Profile Values window opens.

2. Check the Site box.

3. Enter ASO% in the Profile Name field.

4. Click the Find button.

The System Profile Values window opens, displaying all existing Quoting 
profile options.

ASO_ORDER_LINE_STATUESES Status of an order line

ASO_ORDER_STATUSES Order status

ASO_PARTY_RELATIONSHIP_
TYPE

Type of party relationship

ASO_QUOTE_RELATED_
OBJECTS

Seeded lookup data required for data 
migration in Sales 

ASO_RETURN_FOR Reasons for returns

ASO_UNIVERSAL_SEARCH Types of universal search

Table 5–2 Obsolete Quoting Lookup Types

Lookup Type Description
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To change profile options, use the standard procedure outlined in the Oracle 
Applications User’s Guide.

5.4 Defining Descriptive Flexfield Information
Descriptive flexfields are customizable, blank fields on the Quoting form that allow 
the application developer to enter additional fields as needed. A descriptive 
flexfield is composed of segments, each of which has a prompt and may have either 
a valid set of values or data entered by the customer. Quoting descriptive flexfields 
are located in the header level, next to the Status field, and in the line level, next to 
the Extended Price field. They are represented by an unnamed field enclosed in 
brackets. 

Use this procedure to determine the use of your descriptive flexfields and to make 
changes to your flexfield values.

Login
Log in to Oracle Forms.

Responsibility
To perform this task, you must use the Application Developer responsibility.

Prerequisites
None.

Steps
1. Choose Flexfield > Descriptive > Segments.

The Descriptive Flexfield form opens.

2. From the View menu, choose Query by Example > Enter.

3. Type Order Capture into the field and choose Query by Example > Run from 
the View menu.

The Oracle Quoting descriptive flexfield records are displayed.

Note: Profile Options marked with an asterisk (*) are 
mandatory. Profile Options marked with a double asterisk 
(**) are conditionally mandatory.
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4. Uncheck the Freeze Flexfield Definition box. This is necessary to make and save 
changes to the flexfield information.

5. Enter the Title field. 

This value is the Title that will show up on the flexfield pop up window.

6. Enter the necessary information into the Context Field section.

This section determines the context of the flexfield.

� Enter a Prompt into the Context field section.

This Prompt appears in a flexfield form if you have permitted override by 
placing a check in the override allowed box.

� Enter a Default Value, if necessary.

This default value determines which descriptive flexfield structure is 
displayed. Your flexfield automatically uses this default value if no 
reference field is defined.

� Enter a Reference Field value, if necessary.

This is the reference field from which the flexfield can automatically derive 
the context value field. Application developers can choose from a 
predefined list or create their own reference fields. For more information, 
refer to the Oracle Applications Flexfield Guide.

� Choose whether or not to require a Context Field Value by checking or 
unchecking the Value Required box.

If a value is required, the user cannot leave the flexfield form without 
entering a valid value. 

Note: In order for flexfields to exist on the quote once it becomes 
an order, the application developer must set up the flexfields in 
Order Management the same as in Oracle Quoting. Therefore you 
must repeat this procedure a second time using Order Management 
as the application.

Note: The content allowed in the Title field and the Context 
section fields is limited by the Value Set. For more information on 
value sets, refer to the Oracle Applications Flexfield Guide.
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� Choose whether or not the user can override the context value derived from 
a reference field or default value by checking or unchecking the Override 
Allowed box.

If the user can change this value, the flexfield form displays the designated 
context window Prompt. If overrides are not allowed, the flexfield value is 
determined by the reference field or default value.

7. Enter as many values as necessary into the Context Field Values section or leave 
the field blank to allow the user to enter their own value.

Each value in this section is part of an LOV on the flexfield pop up window, 
from which the user can choose. 

8. Click Segments.

The Segments Summary form opens.

9. Enter a name for the segment in the first available Name field.

10. Enter a Window Prompt for the segment.

11. Optionally, use the LOV to enter the column the segment should map to.

12. Click Value Set to set the values and close this form.

13. In the descriptive flexfield form, place a check in the Freeze Flexfield Definition 
box.

This is necessary to save all of the changes made in this form.

14. Click Compile to apply your changes and close the main descriptive flexfield 
form.

5.5 Setting Up the Print Quote Functionality
Before using Print Quote you must install and designate a default printer. For 
complete directions on Installing a Printer, see the Oracle Applications System 
Administrator’s Guide. 

5.5.1 Designating a Printer for Print Quote

Login
Log in to Oracle Forms.
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Responsibility
To perform this task, you must use the Application Developer responsibility.

Prerequisites
None.

Steps
1. Choose Concurrent > Program.

The Concurrent Programs window opens.

2. Choose View > Query by Example > Enter.

3. Enter Print Quote in the Program field.

4. Choose View > Query by Example > Run.

Quoting displays the Print Quote record. The default printer is located in the 
Output section in the lower right corner.

5. To change the printer, click on the LOV in the printer field. 

A window opens, displaying all printers that are set up in Oracle Forms.

6. Choose the printer you want your Print Quote reports to print on.

7. Click OK.

8. Close the window.

5.5.2 Customizing the Print Quote Report
Currently, you can customize the print quote report with your company logo and 
address. You must first update the report with your information in Oracle Report 
Builder.

For more information on Oracle Reports and Oracle Report Builder, see Oracle 
Reports Developer Building Reports or Oracle Reports Developer Reference Manual.

Login
Log in to Report Builder.

Responsibility
To perform this task, you must use the System Administrator responsibility.
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Prerequisites
None.

Steps
1. Log in to Report Builder.

2. Choose Open from the File menu.

3. Locate the report named ASOPQTER.rdt and click Open.

4. Click the plus sign to the left of the report name to expand the report options.

5. Double-click on Layout Model to open the layout.

The Oracle Reports layout window opens.

6. Click Edit Margin.

The margin layout appears.

a. To edit the Company Address:

* Click on the Company Address text.

A text box appears around the Company Address text and you are now 
able to edit it.

* Type your company’s address.

* Click the Save icon.

b. To edit the company logo:

* Delete the Company Logo textbox 

* Place your cursor on or near the company logo text.

* From the File menu, choose Import > Image.

* Browse for your logo file.

* Click OK.

* Click on the company logo.

A box appears around the company logo image and you are now able 
to edit it.

* Click the Save icon.
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5.6 Setting up GSA (General Services Administration) Pricing
GSA is a customer classification that indicates that the customer is a U.S. 
government customer. Specific GSA price lists for the customers must be set up in 
Pricing. Items listed on the GSA price list cannot be sold to commercial customers 
for the same price or less than the government.

Quoting responds to GSA violations based on the application level profile option 
ASO: GSA Pricing. As a default, the profile option is set to Null, which means that 
the application is not performing GSA violation checks. If the profile option is set to 
Warning and a non-GSA customer receives a unit net price that is lower than the 
GSA price, a violation warning appears stating that there is a GSA violation. If the 
profile option is set to Error, the user will be prevented from updating or saving the 
quote. In either case, if a GSA violation occurs, an error message appears 
identifying the quote lines in which the violation occurred.

Refer to the Oracle Pricing User’s Guide for more information.

5.7 Creating Additional Attachments Document Categories
Quoting currently supports one document category, Miscellaneous, which 
automatically defaults into the Document Category field when you create a new 
attachment. Yet, you can create other customized categories to meet your business 
needs.

The following procedure allows you to add new document categories for 
attachments and associate them with Quoting.

Login
Log in to Oracle Forms.

Responsibility
To perform this task, you can use either the Application Developer responsibility or 
the Order Management Super User responsibility.

Note: To enable GSA validation, you must set the Pricing profile 
option QP: Verify GSA to yes.
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Prerequisites
None

Steps
1. Log in to Oracle Forms.

� If you logged in to Oracle Forms using the Application Developer 
responsibility, than choose Attachments > Document Categories from the 
Navigator.

� If you logged in to Oracle Forms using the  Order Management Super User 
responsibility, then choose Setup > Orders > Attachments > Document 
Categories.

The Document Categories form opens.

2. Enter a name for your new document category.

3. Select a datatype from the Default Datatype LOV.

The possible datatypes are:

� Short Text

� Long Text

� Web Page

� File

� Document Reference

4. Select effective dates for the category using the From and To LOVs.

5. Click Assignments.

The Category Assignments form opens.

6. Select Function from the Type LOV.

7. Select Quoting from the Name LOV.

8. Optionally, select a format from the Format LOV.

9. Ensure that the Enabled box is checked.

10. Click the Save icon.

11. Close the form.
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Your new document category now appears as an option in the Category field on 
the Attachments form.

For more information on setting up attachments, refer to the latest release of the 
Oracle Application Developer’s Guide. For more information on using attachments. 
refer to Oracle Quoting - Forms Concepts and Procedures or Oracle Applications User’s 
Guide.
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6
Verifying the Implementation

This topic group provides you with steps necessary to verify implementation of 
Oracle Quoting.

� Oracle Quoting Implementation Verification Tasks
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6.1 Oracle Quoting Implementation Verification Tasks
To verify that you properly implemented Quoting, perform the following tasks.

For information on how to perform these procedures, see Oracle Quoting - Forms 
Concepts and Procedures.

1. Create a complex quote.

� Add and configure a model item.

� Check item availability.

� Convert the quote into an order. 

You should receive confirmation that your order was submitted. Verify that 
the procedure was successful in Order Management. 
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7
Diagnostics and Troubleshooting

This topic group provides troubleshooting information for the implementation and 
use of Oracle Quoting.

� Troubleshooting

� How to Set up Debugging when Logging an iTar to Send to Support

� Order Feedback Queue Frequently Asked Questions
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7.1 Troubleshooting
If you have any problems using Quoting: 

� Make sure that Quoting is fully installed.

� Recompile the server objects.

� After recompiling server objects, regenerate forms and libraries. 

7.2 How to Set up Debugging when Logging an iTar to Send to Support
Use the following procedures to set up debugging in Quoting.

7.2.1 Setting Up Debug File Location 
The debug file will help Oracle easily debug the cause of your problem. This is 
mandatory for all bugs logged against Quoting Patchset E or later.

Steps
1. Ensure that the Order Management profile OE_DEBUG_LOG_DIRECTORY is 

set. 

2. Ensure that the profile value used above matches the utl_file_dir parameter of 
init.ora 

7.2.2 How to Use Debugger From the Quoting Main Form
Use the following procedure to employ the debugger in the main Quoting form.

Steps
1. Check ASO Debug under Tools menu. 

2. Note the debug file name and location. 

3. Execute the steps necessary to reproduce the bug. 

The debug file is generated in the directory mentioned in the Order 
Management profile OE_DEBUG_LOG_DIRECTORY. 

7.2.3 How to Use Debugger in SQL Scripts
Use the following procedure to employ the debugger in SQL scripts.
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Steps
1. Use the following statements at the start of your SQL script: 

aso_debug_pub.initialize; 
         aso_debug_pub.debug_on; 
         aso_debug_pub.setdebuglevel(10); 
         l_file    := aso_debug_pub.set_debug_mode(’FILE’); 
         dbms_output.put_line(’File :’||l_file); 

2. Execute the SQL script to reproduce the bug. 

3. Note the debug file name and location. 

4. The debug file will get generated in the directory mentioned in the Order 
Management profile OE_DEBUG_LOG_DIRECTORY.

7.3 Order Feedback Queue Frequently Asked Questions
Question: The queue table ASO_ORDER_FEEDBACK_T is growing in size. How 
do I stop it from growing?

Answer: Log in to Oracle Forms using the Oracle Quoting Sales Manager 
responsibility and navigate to QuickCodes. Delete or disable all the lookup entries 
for lookup ‘ASO_ORDER_FEEDBACK_CRM_APPS’.

Question: The install base concurrent program is reading the rows from the queue 
table. Why are the rows read by the concurrent program still there?

Answer: The messages are being removed by the Installed Base program, but new 
messages that are queuing for different consumers are not being dequeued or 
inspected at all. This happens if there is a registered consumer in the ASO lookup 
(ASO_ORDER_FEEDBACK_CRM_APPS) for which there  is no dequeueing 
program. Delete or disable all the lookup entries except for Install Base for lookup 
‘ASO_ORDER_FEEDBACK_CRM_APPS’ in the QuickCodes form.

Question: The queue table is growing in size. I do not need the queue table because 
I do not have any CRM applications that depend on it. How can I remove all the 
rows in the table?

Answer: Perform the following tasks:
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� Log in to Oracle Forms using the Oracle Quoting Sales Manager responsibility 
and navigate to QuickCodes. Delete or disable all the lookup entries for lookup 
‘ASO_ORDER_FEEDBACK_CRM_APPS’.

� Apply ARU bug 1449198 which drops the queue table and recreates it.

Question: The Installed Base Interface Concurrent Program completes with  an 
error status with a fatal exception from the ASO_ORDER_FEEDBACK_GET_PVT 
API. FND_AS_UNEXPECTED_ERROR (PKG_NAME=ASO_ORDER_FEEDBACK_
GET_PVT) (PROCEDURE_NAME=GET_NOTICE) (ERROR_TEXT=ORA-00600: 
internal error code, arguments: [koxsi2sz1], [13], [], [], [], [], [], []). What does this 
mean?

Answer: This error occurs because of bug 1424051 in RDBMS. Customers have to 
apply a patch to avoid this problem. The only workaround is to drop the rows in 
the table. For this, a standalone ARU 1449198 needs to be applied which will drop 
and recreate the queue.

Question: Bug 1816891: Placing an order in OM or OC throws the error: FND_AS_
UNEXPECTED_ERROR (PKG_NAME=ASO_ORDER_FEEDBACK_UPDATE_PVT) 
(PROCEDURE_NAME =UPDATE_NOTICE) (ERROR_TEXT=ORA-25207: enqueue 
failed, queue ASO.ASO_OF_Q is disabled from enqueueing). Why does this 
happen?

Answer: This error occurs because the queue is not enabled for enqueuing.  The 
following SQL commands need to be run as APPS user to enable the queue for 
enqueuing and dequeuing:

execute dbms_aqadm.start_queue(’ASO.ASO_OF_Q’, TRUE, TRUE); 
execute dbms_aqadm.start_queue(’ASO.ASO_OF_Q_E’, FALSE,TRUE); 
execute dbms_aqadm.start_queue(’ASO.ASO_OF_EXCP_Q’, TRUE, TRUE); 
execute dbms_aqadm.start_queue(’ASO.ASO_OF_EXCP_Q_E’, FALSE,TRUE);

Question: Bug 1897375: Placing an order in OM or OC throws an error: 100501 - 
non-Oracle Exception. The debug file shows the error. FND_AS_UNEXPECTED_
ERROR (PKG_NAME=ASO_ORDER_FEEDBACK_UPDATE_PVT) (PROCEDURE_
NAME=UPDATE_NOTICE) (ERROR_TEXT=ORA-06502: PL/SQL: numeric or 
value error: character to number conversion error). Why does this happen?

Answer: The error occurs when the profile value ASO: Order Feedback Queue 
Retention Time was set to a character string.
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The profile value ASO: Order Feedback Queue Retention Time  is used to determine 
how long the message is retained in the Order Feedback Queue. Either the value 
should be null (the message never expires) or a number in seconds. Set the profile 
value to null or a large number.
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A
Oracle Quoting Profile Options

This chapter describes the profile options that you need to set when implementing 
Oracle Quoting.

� Current Oracle Quoting Profile Options

� Obsolete Quoting Profile Options
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A.1 Current Oracle Quoting Profile Options
When implementing Quoting, you must set certain profile options, which affect the 
appearance and performance of the application. 

The following tables list descriptions and default values for each of the Quoting 
profile options.

Note: Profile options with an asterisk are mandatory. Profile 
options with a double asterisk are conditionally mandatory.

Table A–1  ASO Profile Options for Configurator Integration

Profile Option Description
Default 
Value

**ASO: Configurator URL This profile specifies the URL for the 
Configurator window.

This profile is mandatory if Oracle 
Configurator is used for product 
configurations.

If this profile value is null, then no 
default value is assumed.

N/A

Table A–2 ASO Profile Options for Contracts Core Integration

Profile Option Description
Default 
Value

ASO: Enable Use Contracts This profile option enables Quoting to 
integrate with Contracts Core.

If this profile is set to Yes, Contracts 
integration is enabled.

If this profile is set to No, Contracts 
integration is disabled.

If this profile is null, then a value of 
No is assumed.

No
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Table A–3 ASO Profile Options for Item ATP Integration

Profile Name Description
Default 
Value

**ASO: ATP Default 
Customer ID

**ASO: ATP Default Ship To 
Site ID

These profiles are set to a cust_accout_
id and cust_account_site_use_id 
(where site_use = Ship_To) values 
respectively. They are used to 
determine the sourcing rules, when no 
ship-to site exists for the quote. These 
profiles must be used in conjunction 
with each other. 

If ATP is performed before selecting a 
ship-to site, these default values are 
used. If a ship-to site is selected, then 
the cust_account_site_use_id is used 
for the ATP check, only if the selected 
site is known to MRP. If MRP is not 
aware of the selected ship-to site, then 
the cust_account_id and the cust_
account_site_use_id specified in these 
profiles is used. Note: Even if MRP is 
aware of the customer and ship-to site, 
but there is no sourcing rule for the 
combination of customer and ship-to 
site, then a Global Sourcing Rule or a 
sourcing rule at the Item level must 
exist for ATP to work.

Note: You should not attempt to set 
these profiles if ASO: ATP Use 
Sourcing Rule is set to No.

A value for these profiles is 
mandatory when ASO: ATP Use 
Sourcing Rule is set to Yes.

If these profile values are null, then no 
default values are assumed.

N/A
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ASO: ATP Use Sourcing 
Rule

This profile determines if sourcing 
rules are used to derive the inventory 
organizations on which ATP needs to 
be done.

Sourcing rules are defined in MRP. 
Please refer to the Oracle Master 
Scheduling/MRP and Oracle Supply 
Chain Planning User Guide Release 11i. 

If this profile is set to Yes, ATP is 
calculated based on sourcing rules.

If this profile is set to No, the sourcing 
rules are not used and the ATP check 
is restricted to the inventory 
Organization specified in the profile 
ASO: Default Ship From Org.

If this profile value is null, then the 
default value NO is assumed.

No

ASO: Automatic ATP Check Determines whether ATP check is 
performed automatically for an item 
in the Item View tab.

If this profile is set to Yes, an ATP 
check is performed automatically 
when an item is added to the quote.

If this profile is set to No, the ATP 
check is skipped.

If this profile value is null, a default 
value of No is assumed.

No

**ASO: Default Ship From 
Org

This profile is used to identify the 
physical warehouse against which 
ATP and reservation are performed.

This profile is mandatory if ATP and 
Reservations are performed.

If this profile value is null, then no 
default value is assumed.

N/A

Table A–3 ASO Profile Options for Item ATP Integration

Profile Name Description
Default 
Value
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Table A–4 ASO Profile Options for Item Reservation Integration

Profile Option Description
Default 
Value

 **ASO: Reservation Level This profile determines the level at 
which item reservations are 
performed. Items can be reserved 
manually, or automatically when the 
order is submitted.

This profile is mandatory if 
reservations are performed.

If this profile is set to AUTO_ORDER, 
a reservation is made when an order is 
placed.

If this profile is set to MANUAL, 
reservations must be entered 
manually.

If this profile value is null, a default 
value of Manual is assumed.

Manual

**ASO: Transaction Source 
Type

This profile is used to specify the 
source type used for reserving items. 
The source type is set up in 
Manufacturing and Distribution, 
logged in as the manager 
responsibility, by navigating to 
Inventory > Setup > Transaction 
Source Type.

This profile is mandatory if 
reservations are performed.

If this profile value is null, no default 
value is assumed.

N/A
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Table A–5 ASO Profile Options for Order Feedback

Profile Option Description
Default 
Value

ASO: Order Feedback 
Queue Retention Time

This profile determines the length of 
time that messages are retained in the 
order feedback queue.

The value of this profile is measured 
in seconds. Therefore, you should set 
the profile value to null (the message 
never expires) or a large number. This 
depends on your business needs and 
the applications that are interested in 
the information in the queue.

Caution: It is very important that you 
enter a value for this profile, because 
your queue can grow extremely large.

If this profile value is null, the 
message will be retained in the queue 
indefinitely.

N/A

Table A–6 ASO Profile Options for Manual Discounts

Profile Option Description
Default 
Value

ASO: Discounting Privilege This profile option allows the user to 
make manual adjustments to the price 
returned from the pricing engine.

If this profile is set to Full, the user can 
manually adjust a price by changing 
the Unit Net Price in the Quoting UI.

If this profile is set to None, the user 
cannot manually adjust a price by 
changing the Unit Net Price in the 
Quoting UI.

If this profile is null, then a value of 
No is assumed.

No
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Table A–7 ASO Profile Options for Order Integration

Profile Option Description
Default 
Value

 *ASO: Default Order State This profile is used to determine the 
state of the order (booked or entered) 
when created from a quote.

If this profile value is null, the default 
value of booked is assumed.

 Booked

**ASO: Default Return 
Reason

This profile is used to default a reason 
for returning an item, if no reason is 
specified by the customer.

This profile is mandatory for all return 
lines.

If this profile value is null, then no 
default value is assumed.

N/A

**ASO: Default Salesrep This profile is used to default in an 
employee_person_id for the sales rep 
on the order, when a quote is 
converted to an order. This default 
salesrep receives 100 percent credit by 
default.

This profile is mandatory when the 
ASO: Validate Salesrep profile is set to 
No.

If this profile value is null, then no 
default value is assumed.

N/A
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ASO: OM Defaulting This profile is used to determine 
whether Oracle Order Management 
should default values (as per rules set 
up in Oracle Order Management) for 
the following attributes of an order, 
when creating an order from a quote: 
salesrep_id, order_type_id, payment_
term_id, fob_code, freight_terms_
code, and shipment_priority_code. 

If this profile is set to No and a quote 
is created with null values for the 
above fields, the corresponding order 
shows these fields as null, except for 
salesrep_id, which is defaulted with a 
value from the Salesrep profile option. 

If this profile is set to Yes and a quote 
is created with null values for the 
above fields, the corresponding order 
will have values defaulted into the 
fields, as per the Order Management 
defaulting rules. 

No

*ASO: Quote Conversion 
Type

This profile specifies the conversion 
type for getting the daily conversion 
rate while creating an order from a 
quote. The conversion type is used to 
derive the daily conversion rate from 
Oracle General Ledger if the OM: Set 
of Books profile currency is different 
from the currency used to create the 
quote.

If this profile value is null, no default 
value is assumed.

N/A

Table A–7 ASO Profile Options for Order Integration

Profile Option Description
Default 
Value
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*ASO: Validate Salesrep This profile is used to determine 
whether a Sales rep must be specified 
on the quote prior to creating an order.

If this profile is set to Yes, a sales 
representative must be specified on 
the quote prior to creating an order.

If this profile is set to No, then a sales 
representative will be defaulted from 
ASO: Default Salesrep.

If this profile value is null, a default 
value of Yes is assumed.

Yes

Table A–8 ASO Profile Options for OTS Integration

Profile Option Description
Default 
Value

ASO: Default E-Business 
Quote Screen

This profile specifies the quote form that 
is launched for Sales for 
Communications. 

If this profile is set to Order Capture, 
then the Quoting form launches.

 If this profile is set to Order Capture 
Navigator or Order Workbench, then 
the respective Sales for Communications  
forms launch.

If this profile value is null, a default 
value of Order Capture is assumed.

Order 
Capture

ASO: Default E-Business 
Order Screen

This profile specifies the Sales Orders 
form that launches for Sales for 
Communications. 

If this profile is set to Order Organizer 
View, then the Order Management Sales 
Orders form opens. 

If this profile is set to Order Details, 
then the Sales for Communications Sales 
Order form opens.

None

Table A–7 ASO Profile Options for Order Integration

Profile Option Description
Default 
Value
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ASO: Enable ASO Debug This profile is only accessible at site 
level and is defined to enable the ASO 
debug messages for a single session.

If this profile is set to Yes, then ASO 
debug messages are recorded in the 
folder specified in Order Management‘s 
profile.

If this profile is set to No, then no debug 
file is recorded.

No

Table A–9 ASO Profile Options for Payments Integration

Profile Option Description
Default 
Value

 ASO: Credit Card 
Authorization

This profile determines whether the 
application does a credit card 
authorization when creating an order 
from a quote.

If this profile is set to Yes, then the 
credit card if authorized when  
creating an order from a quote.

If this profile is set to No, no credit 
card authorization is performed.

If this profile value is null, then a 
default value of No is assumed.

No

**ASO: Receipt Method This profile determines the receipt 
method for credit card authorization. 

This profile option is mandatory when 
ASO: Credit Card Authorization is set 
to Yes.

If this profile value is null, no default 
value is assumed.

N/A

Table A–8 ASO Profile Options for OTS Integration

Profile Option Description
Default 
Value
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Table A–10 ASO Profile Options for Pricing

Profile Option Description
Default 
Value

ASO: GSA Pricing This option allows users to check the 
GSA violation returned by the Pricing 
engine.

If this profile is set to Warning, then it 
checks for a GSA violation and returns 
a warning message to the user, yet the 
transaction continues.

If this profile is set to Error, then it 
checks for a GSA violation and returns 
an error message to the user, and rolls 
back the transaction.

If this profile value is null, GSA 
violation checks are ignored.

N/A

Table A–11 ASO Profile Options for Quotes

Profile Option Description
Default 
Value

ASO: Automatic 
Numbering

Determines if the system 
automatically generates a quote 
number. 

If this profile is set to Yes, a new quote 
number is generated by the system.

If this profile is set to No, the user 
must specify the quote number.

If this profile value is null, the user 
must specify the quote number.

Yes
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*ASO: Create Customer 
Account

This profile option enables creation of 
customer accounts and customer 
account relationships.

If this profile is set to Yes, Quoting 
automatically creates accounts and 
account relationships, if none exist, at 
the time of creating or updating a 
quote.

If this profile is set to No, Quoting will 
mandate that a valid account 
relationship exist in order to be able to 
create or update a quote.

Yes

*ASO: Default Currency 
Code

One of the two profile options that 
determine the currency of the 
transactions in the application. The 
currency defined in ASO: Default 
Order Type takes precedence over this 
profile option.

If this profile value is null, the default 
value USD is assumed.

USD

ASO: Default Customer 
Type

This profile option determines the 
Customer Type (person or 
organization) field for the sold-to, 
bill-to, and ship-to customers.

If this profile is set to Person, the 
customer type of the sold-to, bill-to, 
and ship-to customers will default to 
person.

If this profile is set to Organization, 
the customer type of the sold-to, 
bill-to, and ship-to customers will 
default to organization.

Organization

ASO: Default Ordered Qty 
in OC UI 

This profile determines the default 
quantity that appears in the QTY field 
of the Quoting window.

If this profile value is null, a default 
quantity of 1 is assumed.

1

Table A–11 ASO Profile Options for Quotes

Profile Option Description
Default 
Value
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ASO: Default Quote Status This profile determines the default 
status of a new quote. 

If this profile value is null, a default 
value of Draft is assumed.

Draft

ASO: Enable Line Payments This profile allows the user to make 
payments at the line level. Currently, 
line level payments are not supported, 
hence this profile should always be set 
to No at the site level.

This profile is non-updateable.

Note: If the customer has customized 
these profiles, the system 
administrator needs to change the 
profile property to make them 
updateable, change the value of both 
the profiles to be No at all levels, and 
make the profiles non-updateable 
again to prevent any accidental 
updates.

No

ASO: Enable Split Payment This profile allows the user split 
payments at the header level across 
multiple payment methods. Currently, 
split payments are not supported, 
hence this profile should always to be 
set to No at site level.

This profile will be non-updateable.

Note: If the customer has customized 
these profiles, the system 
administrator needs to change the 
profile property to make them 
updateable, change the value of both 
the profiles to be No at all levels, and 
make the profiles non-updateable 
again to prevent any accidental 
updates.

No

Table A–11 ASO Profile Options for Quotes

Profile Option Description
Default 
Value
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ASO: Quote Duration This profile specifies the minimum 
length of time a quote remains valid. 
The Quoting UI uses this value to 
calculate the Expiration Date if the 
user does not specify one.

If this profile value is null, a duration 
of 30 is assumed.

30

Table A–12 ASO Profile Options for Quote/Order Integration

Profile Option Description
Default 
Value

*ASO: Default Order Type This profile determines how the order 
is to be processed in Oracle Order 
Management. The order types are set 
up in Oracle Order Management. This 
profile also determines what price list 
and currency code appear by default 
in the main Quoting form. 

If this profile value is null, no default 
value is assumed.

Note: Set up of this profile is 
mandatory for tax calculations.

N/A

ASO: Enable TCA Changes This profile will enable the new 
validation/derivation logic related to 
the TCA attributes in the Quoting 
APIs. This profile should only be used 
internally by the development teams 
and should not be set by customers.

If this profile is set to Yes, the new 
validation/derivation logic is 
executed.

If this profile is set to No, the old 
validation/derivation logic will not be 
executed.

If this profile value is null, a default 
value of No is assumed.

No

Table A–11 ASO Profile Options for Quotes

Profile Option Description
Default 
Value
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Table A–13 ASO Profile Options for Security

Profile Option Description
Default 
Value

ASO: Enable Security Check This profile turns the Quoting security 
on or off. It is set at the site level.

If this profile is set to Yes, the security 
profile is turned on. This means that 
the sales representatives who log in to 
OC can query and update only their 
own quotes, unless they are assigned a  
manager role.

If this profile is set to No, the security 
profile is turned off. All users can 
query and update all quotes.

If this profile value is null, a value of 
No is assumed.

No

ASO: Enable Submit Button This profile decides which users can 
submit orders.

If this profile is set to Yes, users can 
submit an order even if they do not 
have a manager role assigned to their 
role type.

If this profile is set to No, the submit 
button is disabled and users cannot 
submit orders.

No

ASO: Role Type This profile is used to assign role types 
to a user. Role types are populated 
from fnd lookup, where lookup type is 
JTF_RS_ROLE_TYPE. 

If this profile is null for a user, that user 
will be outside of the security system 
even if the security profile is set to Yes.

N/A
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ASO: OM Access This profile determines the mode of 
access to Oracle Order Management 
forms via the Customer History form. 
Access can be Full or Read Only. These 
values are based on the lookup type 
ASO_OM_ACCESS_PRIVILEGE.

If this profile is set to Full, the user can 
update an order in the Oracle Order 
Management form.

If this profile is set to Read Only, the 
user can only view an order in the 
Oracle Order Management form.

If this profile value is null, a value of 
Full is assumed.

Full

Table A–14 ASO Profile Options for Tax Integration

Profile Option Description
Default 
Value

* ASO: Email Address to 
send Diagnostic Messages

This profile option determines whether 
the application sends an email 
containing debug statements and AR 
global variables when there is an 
exception in the Order Capture Tax API.

If this profile is set to Yes, then an email 
is sent to the email address specified in 
the profile.

If this profile is set to No, then no email 
is sent when there is an exception in 
Order Capture Tax API.

This profile is only accessible at site 
level.

No

Table A–13 ASO Profile Options for Security

Profile Option Description
Default 
Value
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* ASO: Enable Email for 
Debug

This profile enables/disables email 
functionality.

If this profile is set to Yes, then a 
workflow engine is called to send an 
email to the address specified in the 
profile option.

If this profile is set to No, email 
functionality is disabled.

This profile is only accessible at site 
level.

No

*ASO: Enable Tax View It determines whether tax integration in 
the Quoting tax API is used. 

If this profile is set to Yes, then Old Tax 
Integration which uses a tax view aso_i_
tax_lines_summary_v is activated. 

If this profile is set to No, then the New 
Tax Integration API, which does not use 
tax view aso_i_tax_lines_summary_v, is 
called.

Note: This profile is only accessible at 
site level.

No

Table A–14 ASO Profile Options for Tax Integration

Profile Option Description
Default 
Value
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Table A–15 ASO Profile Options for Trade-Ins

Profile Option Description
Default 
Value

ASO: Enable Line Type This profile allows the use to enter line 
types and categories. Some 
installations may not want the 
functionality for trade-ins and would 
therefore turn the profile off.

If this profile is set to Yes, lines types 
and categories are enterable in the 
Quoting UI.

If this profile is set to No, line types 
and categories are not enterable and 
the default line category "ORDER" is 
in effect in the Quoting UI.

If this profile value is null, a default 
value of No is assumed.

No
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A.2 Obsolete Quoting Profile Options
The following table lists the Quoting profile options that are obsolete in this release.

Table A–16 Obsolete Quoting Profile Options

Profile Option Description

ASO: Advanced Inbound 
Installation

Determines if Oracle Advanced Inbound is 
installed

ASO: Advanced Outbound 
Installation

Determines if Oracle Advanced Outbound is 
installed

ASO: Automatic ATP Check for 
Number of Items

Automatic ATP check to be performed for 
number of items

ASO: Default Order Category   Determines whether all items in an order are 
orders or returns

ASO: Default Payment Option Default payment option

ASO: Enable Configure Model 
Item

Enables configuration of model items

ASO: Payment Term Payment term associated with a newly created 
account

ASO: Product Organization The organization that OC uses to validate 
product inventory items

ASO: Quote Order Type System default order type that quote uses

ASO: Quote Order Entered State The entered state of orders when entered from 
quotes

ASO: Scripting Installation Determines if Oracle Scripting is used

ASO: Use Installation Details Use Installation Details UI
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B
Oracle Order Capture Foundation Public

APIs

This appendix contains information about Oracle Order Capture Foundation’s 
public APIs, which are used by Oracle Quoting. The following sections describe the 
various PL/SQL APIs that are supported. 

� Oracle Order Capture Foundation Public Packages

� Package ASO_QUOTE_PUB

� Package ASO_ORDER_INT
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B.1 Oracle Order Capture Foundation Public Packages
There are two packages that encompass the Oracle Order Capture Foundation 
public APIs, One package pertains to quotes, while the other is specific to orders.

� Package ASO_QUOTE_PUB, see Table 2-1, "Quote APIs"

� Package ASO_ORDER_INT, see Table 2-2, "Order APIs"

The following tables describe public APIs, which are discussed in this chapter.

Table 7–1 Quote APIs

Name Description

Create_Quote The Create_Quote API creates an entire quote 
including the quote header, shipment, payment, and 
line level payments and shipments. 

Create_Quote (overloaded) Create_Quote overloaded with Sales Credit and 
Quote Party input.

Update_Quote The Update_Quote API updates a quote in Quoting.

Update_Quote (overloaded) Update_Quote API overloaded with Sales Credit and 
Quote Party input.

Copy_Quote The Copy_Quote API copies the existing quote to a 
new quote. 

Copy_Quote (overloaded) Copy_Quote API overloaded with Sales Credit and 
Quote Party input.

Submit_Quote The Submit_Quote API converts a quote into an order. 

Table 7–2 Order APIs

Name Description

Create_Order The Create_Order API creates a new order in Oracle 
Order Management. 

Update_Order The Update_Order API allows for updates to an 
existing order in Oracle Order Management.



Package ASO_QUOTE_PUB

Oracle Order Capture Foundation Public APIs B-3

B.2 Package ASO_QUOTE_PUB
Following is a list of Oracle Order Capture Foundation APIs in the package ASO_
QUOTE_PUB. These APIs pertain to the quoting aspect of Quoting. They are used 
to create, update, copy, and submit (to Oracle Order Management) quotes in 
Quoting.

� Create_Quote

� Create_Quote (overloaded)

� Update_Quote

� Update_Quote (overloaded)

� Copy_Quote

� Copy_Quote (overloaded)

� Submit_Quote

B.2.1 Create_Quote
The Create_Quote API creates an entire quote including the quote header, shipment, 
payment, and line level payments and shipments. It also calculates prices for items 
included in the quote based on necessary tax, and shipping and freight charges. 
Create_Quote calls Create_Quote_Lines for creating quote lines, line shipments, and 
line payments. 

The following interface APIs are called in Create_Quote: Pricing, Tax, and Service 
Contracts (for serviceable items).

Parameter Descriptions
The following table lists the IN parameters for the Create_Quote API.

Table 7–3 Create_Quote IN Parameters

Parameter Data Type

P_Api_Version_Number NUMBER,

P_Init_Msg_List VARCHAR2 := FND_API.G_FALSE,

P_Commit VARCHAR2 := FND_API.G_FALSE,

P_Control_Rec Control_Rec_Type := G_Miss_Control_Rec,

P_Qte_Header_Rec Qte_Header_Rec_Type := G_MISS_Qte_Header_Rec
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P_hd_Price_Attributes_Tbl ASO_QUOTE_PUB.Price_Attributes_Tbl_Type := 
G_Miss_Price_Attributes_Tbl,

P_hd_Payment_Tbl ASO_QUOTE_PUB.Payment_Tbl_Type:= G_MISS_
PAYMENT_TBL,

P_hd_Shipment_Rec ASO_QUOTE_PUB.Shipment_Rec_Type := G_
MISS_SHIPMENT_REC,

P_hd_Freight_Charge_Tbl ASO_QUOTE_PUB.Freight_Charge_Tbl_Type :=

G_Miss_Freight_Charge_Tbl,

P_hd_Tax_Detail_Tbl ASO_QUOTE_PUB.Tax_Detail_Tbl_Type:= G_
Miss_Tax_Detail_Tbl,

P_Qte_Line_Tbl Qte_Line_Tbl_Type := G_MISS_QTE_LINE_TBL,

P_Qte_Line_Dtl_Tbl Qte_Line_Dtl_Tbl_Type := G_MISS_QTE_LINE_
DTL_TBL,

P_Line_Attr_Ext_Tbl Line_Attribs_Ext_Tbl_Type := G_MISS_Line_
Attribs_Ext_TBL,

P_line_rltship_tbl Line_Rltship_Tbl_Type := G_MISS_Line_Rltship_
Tbl,

P_Price_Adjustment_Tbl Price_Adj_Tbl_Type := G_Miss_Price_Adj_Tbl,

P_Price_Adj_Attr_Tbl Price_Adj_Attr_Tbl_Type := G_Miss_PRICE_ADJ_
ATTR_Tbl,

P_Price_Adj_Attr_Tbl Price_Adj_Attr_Tbl_Type := G_Miss_PRICE_ADJ_
ATTR_Tbl,

P_Price_Adj_Rltship_Tbl Price_Adj_Rltship_Tbl_Type := G_Miss_Price_Adj_
Rltship_Tbl,

P_Ln_Price_Attributes_Tbl Price_Attributes_Tbl_Type := G_Miss_Price_
Attributes_Tbl,

P_Ln_Payment_Tbl Payment_Tbl_Type := G_MISS_PAYMENT_TBL,

P_Ln_Shipment_Tbl Shipment_Tbl_Type := G_MISS_SHIPMENT_TBL,

P_Ln_Freight_Charge_Tbl Freight_Charge_Tbl_Type := G_Miss_Freight_
Charge_Tbl,

P_Ln_Tax_Detail_Tbl Tax_Detail_Tbl_Type := G_Miss_Tax_Detail_Tbl,

Table 7–3 Create_Quote IN Parameters

Parameter Data Type
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The following table lists the OUT parameters for the Create_Quote API.

B.2.2 Create_Quote (overloaded)
Create_Quote overloaded with Sales Credit and Quote Party input.

Table 7–4 Create_Quote OUT Parameters

Parameter Data Type

x_Qte_Header_Rec Qte_Header_Rec_Type,

X_Qte_Line_Tbl Qte_Line_Tbl_Type,

X_Qte_Line_Dtl_Tbl Qte_Line_Dtl_Tbl_Type,

X_Hd_Price_Attributes_Tbl Price_Attributes_Tbl_Type,

X_Hd_Payment_Tbl Payment_Tbl_Type,

X_Hd_Payment_Rec Shipment_Rec_Type,

X_Hd_Freight_Charge_Tbl Freight_Charge_Tbl_Type,

X_Hd_Tax_Detail_Tbl Tax_Detail_Tbl_Type,

x_Line_Attr_Ext_Tbl Line_Attribs_Ext_Tbl_Type,

X_Line_Rltship_Tbl Line_Rltship_Tbl_Type,

X_Price_Adjustment_Tbl Price_Adj_Tbl_Type,

X_Price_Adj_Attr_Tbl Price_Adj_Attr_Tbl_Type,

X_Price_Adj_Rltship_Tbl Price_Adj_Rltship_Tbl_Type,

X_Ln_Price_Attributes_Tbl Price_Attributes_Tbl_Type,

X_Ln_Payment_Tbl Payment_Tbl_Type,

X_Ln_Shipment_Tbl Shipment_Tbl_Type,

X_Ln_Freight_Charge_Tbl Freight_Charge_Tbl_Type,

X_Ln_Tax_Detail_Tbl Tax_Detail_Tbl_Type,

X_Return_Status VARCHAR2,

X_Msg_Count NUMBER,

X_Msg_Data VARCHAR2
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Parameter Descriptions
The following table lists the IN parameters for the Create_Quote API (overloaded) 
API.

Table 7–5 Create_Quote (overloaded) IN Parameters

Parameter Data Type

P_Api_Version_Number NUMBER,

P_Init_Msg_List VARCHAR2 := FND_API.G_FALSE,

P_Commit VARCHAR2 := FND_API.G_FALSE,

P_Control_Rec Control_Rec_Type := G_Miss_Control_Rec,

P_Qte_Header_Rec Qte_Header_Rec_Type := G_MISS_Qte_Header_
Rec

P_hd_Price_Attributes_Tbl ASO_QUOTE_PUB.Price_Attributes_Tbl_Type := 
G_Miss_Price_Attributes_Tbl,

P_hd_Payment_Tbl ASO_QUOTE_PUB.Payment_Tbl_Type:= G_MISS_
PAYMENT_TBL,

P_hd_Shipment_Rec ASO_QUOTE_PUB.Shipment_Rec_Type := G_
MISS_SHIPMENT_REC,

P_hd_Freight_Charge_Tbl ASO_QUOTE_PUB.Freight_Charge_Tbl_Type :=

G_Miss_Freight_Charge_Tbl,

P_hd_Tax_Detail_Tbl ASO_QUOTE_PUB.Tax_Detail_Tbl_Type:=G_
Miss_Tax_Detail_Tbl,

P_Qte_Line_Tbl Qte_Line_Tbl_Type :=G_MISS_QTE_LINE_TBL,

P_Qte_Line_Dtl_Tbl Qte_Line_Dtl_Tbl_Type :=G_MISS_QTE_LINE_
DTL_TBL,

P_Line_Attr_Ext_Tbl Line_Attribs_Ext_Tbl_Type :=G_MISS_Line_
Attribs_Ext_TBL,

P_line_rltship_tbl Line_Rltship_Tbl_Type :=G_MISS_Line_Rltship_
Tbl,

P_Price_Adjustment_Tbl Price_Adj_Tbl_Type := G_Miss_Price_Adj_Tbl,

P_Price_Adj_Attr_Tbl Price_Adj_Attr_Tbl_Type := G_Miss_PRICE_ADJ_
ATTR_Tbl,

P_Price_Adj_Rltship_Tbl Price_Adj_Rltship_Tbl_Type := G_Miss_Price_Adj_
Rltship_Tbl,
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The following table lists the OUT parameters for the Create_Quote API 
(overloaded) API.

P_Ln_Price_Attributes_Tbl Price_Attributes_Tbl_Type := G_Miss_Price_
Attributes_Tbl,

P_Ln_Payment_Tbl Payment_Tbl_Type := G_MISS_PAYMENT_TBL,

P_Ln_Shipment_Tbl Shipment_Tbl_Type := G_MISS_SHIPMENT_TBL,

P_Ln_Freight_Charge_Tbl Freight_Charge_Tbl_Type := G_Miss_Freight_
Charge_Tbl,

P_Ln_Tax_Detail_Tbl Tax_Detail_Tbl_Type := G_Miss_Tax_Detail_Tbl,

Table 7–6 Create_Quote (overloaded) OUT Parameters

Parameter Data Type

x_Qte_Header_Rec Qte_Header_Rec_Type,

X_Qte_Line_Tbl Qte_Line_Tbl_Type,

X_Qte_Line_Dtl_Tbl Qte_Line_Dtl_Tbl_Type,

X_Hd_Price_Attributes_Tbl Price_Attributes_Tbl_Type,

X_Hd_Payment_Tbl Payment_Tbl_Type,

X_Hd_Shipment_Rec Shipment_Rec_Type,

X_Hd_Freight_Charge_Tbl Freight_Charge_Tbl_Type,

X_Hd_Tax_Detail_Tbl Tax_Detail_Tbl_Type,

x_Line_Attr_Ext_Tbl Line_Attribs_Ext_Tbl_Type,

X_Line_Rltship_Tbl Line_Rltship_Tbl_Type,

X_Price_Adjustment_Tbl Price_Adj_Tbl_Type,

X_Price_Adj_Attr_Tbl Price_Adj_Attr_Tbl_Type,

X_Price_Adj_Rltship_Tbl Price_Adj_Rltship_Tbl_Type,

X_Ln_Price_Attributes_Tbl Price_Attributes_Tbl_Type,

X_Ln_Payment_Tbl Payment_Tbl_Type,

X_Ln_Shipment_Tbl Shipment_Tbl_Type,

Table 7–5 Create_Quote (overloaded) IN Parameters

Parameter Data Type
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B.2.3 Update_Quote
The Update_Quote API updates a quote in Quoting. Update_Quote can perform the 
following operations: 

� Create quote lines and line shipment, line payment, and other line attributes 

� Update quote lines to update the existing quote lines, and other line attributes. 

� Update_Quote also recalculates item prices after adding or updating lines.

The following APIs are called in Update_Quote: Pricing, Tax, and Service Contracts 
(for Serviceable Items).

Parameter Descriptions
The following table describes the IN parameters associated with this API.

X_Ln_Freight_Charge_Tbl Freight_Charge_Tbl_Type,

X_Ln_Tax_Detail_Tbl Tax_Detail_Tbl_Type,

X_Ln_Sales_Credit_Tbl Sales_Credit_Tbl_Type

X_Ln_Quote_Party_Tbl Quote_Party_Tbl_Type

X_Return_Status VARCHAR2,

X_Msg_Count NUMBER,

X_Msg_Data VARCHAR2

Table 7–7 Update_Quote IN Parameters

Parameter Data Type

P_Api_Version_Number NUMBER,

P_Init_Msg_List VARCHAR2 := FND_API.G_FALSE,

P_Commit VARCHAR2 := FND_API.G_FALSE,

P_Control_Rec Control_Rec_Type := G_Miss_Control_Rec,

P_Qte_Header_Rec Qte_Header_Rec_Type := G_MISS_Qte_Header_
Rec

P_hd_Price_Attributes_Tbl ASO_QUOTE_PUB.Price_Attributes_Tbl_Type := 
G_Miss_Price_Attributes_Tbl,

Table 7–6 Create_Quote (overloaded) OUT Parameters

Parameter Data Type
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The following table describes the OUT parameters associated with this API.

P_hd_Payment_Tbl ASO_QUOTE_PUB.Payment_Tbl_Type := G_
MISS_PAYMENT_TBL,

P_hd_Shipment_Rec ASO_QUOTE_PUB.Shipment_Rec_Type  := G_
MISS_SHIPMENT_REC,

P_hd_Freight_Charge_Tbl ASO_QUOTE_PUB.Freight_Charge_Tbl_Type :=

G_Miss_Freight_Charge_Tbl,

P_hd_Tax_Detail_Tbl ASO_QUOTE_PUB.Tax_Detail_Tbl_Type := G_
Miss_Tax_Detail_Tbl,

P_Qte_Line_Tbl Qte_Line_Tbl_Type := G_MISS_QTE_LINE_TBL,

P_Qte_Line_Dtl_Tbl Qte_Line_Dtl_Tbl_Type := G_MISS_QTE_LINE_
DTL_TBL,

P_Line_Attr_Ext_Tbl Line_Attribs_Ext_Tbl_Type := G_MISS_Line_
Attribs_Ext_TBL,

P_line_rltship_tbl Line_Rltship_Tbl_Type := G_MISS_Line_Rltship_
Tbl,

P_Price_Adjustment_Tb Price_Adj_Tbl_Type := G_Miss_Price_Adj_Tbl,

P_Price_Adj_Attr_Tbl Price_Adj_Attr_Tbl_Type := G_Miss_PRICE_ADJ_
ATTR_Tbl,

P_Price_Adj_Rltship_Tbl Price_Adj_Rltship_Tbl_Type := G_Miss_Price_Adj_
Rltship_Tbl,

P_Ln_Price_Attributes_Tbl Price_Attributes_Tbl_Type := G_Miss_Price_
Attributes_Tbl,

P_Ln_Payment_Tbl Payment_Tbl_Type := G_MISS_PAYMENT_TBL,

P_Ln_Shipment_Tbl Shipment_Tbl_Type := G_MISS_SHIPMENT_TBL,

P_Ln_Freight_Charge_Tbl Freight_Charge_Tbl_Type := G_Miss_Freight_
Charge_Tbl,

P_Ln_Tax_Detail_Tbl Tax_Detail_Tbl_Type := G_Miss_Tax_Detail_Tbl,

Table 7–7 Update_Quote IN Parameters

Parameter Data Type
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B.2.4 Update_Quote (overloaded)
Update_Quote API overloaded with Sales Credit and Quote Party input.

Parameter Descriptions
The following table describes the IN parameters associated with this API.

Table 7–8 Update_Quote OUT Parameters

Parameter Data Type

x_Qte_Header_Rec Qte_Header_Rec_Type,

X_Qte_Line_Tbl Qte_Line_Tbl_Type,

X_Qte_Line_Dtl_Tbl Qte_Line_Dtl_Tbl_Type,

X_Hd_Price_Attributes_Tbl Price_Attributes_Tbl_Type,

X_Hd_Payment_Tbl Payment_Tbl_Type,

X_Hd_Shipment_Rec Shipment_Rec_Type,

X_Hd_Freight_Charge_Tbl Freight_Charge_Tbl_Type,

X_Hd_Tax_Detail_Tbl Tax_Detail_Tbl_Type,

x_Line_Attr_Ext_Tbl Line_Attribs_Ext_Tbl_Type,

X_line_rltship_tbl Line_Rltship_Tbl_Type,

X_Price_Adjustment_Tbl Price_Adj_Tbl_Type,

X_Price_Adj_Attr_Tbl Price_Adj_Attr_Tbl_Type,

X_Price_Adj_Rltship_Tbl Price_Adj_Rltship_Tbl_Type,

X_Ln_Price_Attributes_Tbl Price_Attributes_Tbl_Type,

X_Ln_Payment_Tbl Payment_Tbl_Type,

X_Ln_Shipment_Tbl Shipment_Tbl_Type,

X_Ln_Freight_Charge_Tbl Freight_Charge_Tbl_Type,

X_Ln_Tax_Detail_Tbl Tax_Detail_Tbl_Type,

X_Return_Status VARCHAR2,

X_Msg_Count NUMBER,

X_Msg_Data VARCHAR2
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Table 7–9 Update_Quote (overloaded) IN Parameters

Parameter Data Type

P_Api_Version_Number NUMBER,

P_Init_Msg_List VARCHAR2 := FND_API.G_FALSE,

P_Commit VARCHAR2 := FND_API.G_FALSE,

P_Control_Rec Control_Rec_Type := G_Miss_Control_Rec,

P_Qte_Header_Rec Qte_Header_Rec_Type := G_MISS_Qte_Header_Rec

P_hd_Price_Attributes_Tbl ASO_QUOTE_PUB.Price_Attributes_Tbl_Type := G_
Miss_Price_Attributes_Tbl,

P_hd_Payment_Tbl ASO_QUOTE_PUB.Payment_Tbl_Type := G_MISS_
PAYMENT_TBL,

P_hd_Shipment_Rec ASO_QUOTE_PUB.Shipment_Rec_Type  := G_MISS_
SHIPMENT_REC,

P_hd_Freight_Charge_Tbl ASO_QUOTE_PUB.Freight_Charge_Tbl_Type :=

G_Miss_Freight_Charge_Tbl,

P_hd_Tax_Detail_Tbl ASO_QUOTE_PUB.Tax_Detail_Tbl_Type := G_Miss_
Tax_Detail_Tbl,

P_Qte_Line_Tbl Qte_Line_Tbl_Type := G_MISS_QTE_LINE_TBL,

P_Qte_Line_Dtl_Tbl Qte_Line_Dtl_Tbl_Type := G_MISS_QTE_LINE_DTL_
TBL,

P_Line_Attr_Ext_Tbl Line_Attribs_Ext_Tbl_Type := G_MISS_Line_Attribs_
Ext_TBL,

P_line_rltship_tbl Line_Rltship_Tbl_Type := G_MISS_Line_Rltship_Tbl,

P_Price_Adjustment_Tb Price_Adj_Tbl_Type := G_Miss_Price_Adj_Tbl,

P_Price_Adj_Attr_Tbl Price_Adj_Attr_Tbl_Type := G_Miss_PRICE_ADJ_
ATTR_Tbl,

P_Price_Adj_Rltship_Tbl Price_Adj_Rltship_Tbl_Type := G_Miss_Price_Adj_
Rltship_Tbl,

P_Ln_Price_Attributes_Tbl Price_Attributes_Tbl_Type := G_Miss_Price_Attributes_
Tbl,

P_Ln_Payment_Tbl Payment_Tbl_Type := G_MISS_PAYMENT_TBL,

P_Ln_Shipment_Tbl Shipment_Tbl_Type := G_MISS_SHIPMENT_TBL,
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The following table describes the OUT parameters associated with this API.

P_Ln_Freight_Charge_Tbl Freight_Charge_Tbl_Type := G_Miss_Freight_Charge_
Tbl,

P_Ln_Tax_Detail_Tbl Tax_Detail_Tbl_Type := G_Miss_Tax_Detail_Tbl,

Table 7–10 Update_Quote (overloaded) OUT Parameters

Parameter Data Type

P_Api_Version_Number NUMBER,

P_Init_Msg_List VARCHAR2 := FND_API.G_FALSE,

P_Commit VARCHAR2 := FND_API.G_FALSE,

P_Control_Rec Control_Rec_Type := G_Miss_Control_Rec,

P_Qte_Header_Rec Qte_Header_Rec_Type := G_MISS_Qte_Header_Rec

P_hd_Price_Attributes_Tbl ASO_QUOTE_PUB.Price_Attributes_Tbl_Type := G_
Miss_Price_Attributes_Tbl,

P_hd_Payment_Tbl ASO_QUOTE_PUB.Payment_Tbl_Type := G_MISS_
PAYMENT_TBL,

P_hd_Shipment_Rec ASO_QUOTE_PUB.Shipment_Rec_Type  := G_MISS_
SHIPMENT_REC,

P_hd_Freight_Charge_Tbl ASO_QUOTE_PUB.Freight_Charge_Tbl_Type :=

G_Miss_Freight_Charge_Tbl,

P_hd_Tax_Detail_Tbl ASO_QUOTE_PUB.Tax_Detail_Tbl_Type := G_Miss_
Tax_Detail_Tbl,

P_Qte_Line_Tbl Qte_Line_Tbl_Type := G_MISS_QTE_LINE_TBL,

P_Qte_Line_Dtl_Tbl Qte_Line_Dtl_Tbl_Type := G_MISS_QTE_LINE_DTL_
TBL,

P_Line_Attr_Ext_Tbl Line_Attribs_Ext_Tbl_Type := G_MISS_Line_Attribs_
Ext_TBL,

P_line_rltship_tbl Line_Rltship_Tbl_Type := G_MISS_Line_Rltship_Tbl,

P_Price_Adjustment_Tb Price_Adj_Tbl_Type := G_Miss_Price_Adj_Tbl,

Table 7–9 Update_Quote (overloaded) IN Parameters

Parameter Data Type
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P_Price_Adj_Attr_Tbl Price_Adj_Attr_Tbl_Type := G_Miss_PRICE_ADJ_
ATTR_Tbl,

P_Price_Adj_Rltship_Tbl Price_Adj_Rltship_Tbl_Type := G_Miss_Price_Adj_
Rltship_Tbl,

P_Ln_Price_Attributes_Tbl Price_Attributes_Tbl_Type := G_Miss_Price_
Attributes_Tbl,

P_Ln_Payment_Tbl Payment_Tbl_Type := G_MISS_PAYMENT_TBL,

P_Ln_Shipment_Tbl Shipment_Tbl_Type := G_MISS_SHIPMENT_TBL,

P_Ln_Freight_Charge_Tbl Freight_Charge_Tbl_Type := G_Miss_Freight_Charge_
Tbl,

P_Ln_Tax_Detail_Tbl Tax_Detail_Tbl_Type := G_Miss_Tax_Detail_Tbl,

x_Qte_Header_Rec Qte_Header_Rec_Type,

X_Qte_Line_Tbl Qte_Line_Tbl_Type,

X_Qte_Line_Dtl_Tbl Qte_Line_Dtl_Tbl_Type,

X_Hd_Price_Attributes_
Tbl 

Price_Attributes_Tbl_Type,

X_Hd_Payment_Tbl Payment_Tbl_Type,

X_Hd_Shipment_Rec Shipment_Rec_Type,

X_Hd_Freight_Charge_Tbl Freight_Charge_Tbl_Type,

X_Hd_Tax_Detail_Tbl Tax_Detail_Tbl_Type,

x_Line_Attr_Ext_Tbl Line_Attribs_Ext_Tbl_Type,

X_line_rltship_tbl Line_Rltship_Tbl_Type,

X_Price_Adjustment_Tbl Price_Adj_Tbl_Type,

X_Price_Adj_Attr_Tbl Price_Adj_Attr_Tbl_Type,

X_Price_Adj_Rltship_Tbl Price_Adj_Rltship_Tbl_Type,

X_Ln_Price_Attributes_Tbl Price_Attributes_Tbl_Type,

X_Ln_Payment_Tbl Payment_Tbl_Type,

X_Ln_Shipment_Tbl Shipment_Tbl_Type,

X_Ln_Freight_Charge_Tbl Freight_Charge_Tbl_Type,

Table 7–10 Update_Quote (overloaded) OUT Parameters

Parameter Data Type
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B.2.5 Copy_Quote
The Copy_Quote API copies the existing quote to a new quote. If p_copy_only_
header is set to FALSE, it copies the header and lines into a new quote. If p_new_
version is set to TRUE, a new version of the current quote will be created.

Parameter Descriptions
The following table describes the IN parameters associated with this API.

The following table describes the OUT parameters associated with this API.

X_Ln_Tax_Detail_Tbl Tax_Detail_Tbl_Type,

X_Ln_Sales_Credit_Tbl Sales_Credit_Tbl_Type,

X_Ln_Quote_Party_Tbl Quote_Party_Tbl_Type,

X_Return_Status VARCHAR2,

X_Msg_Count NUMBER,

X_Msg_Data VARCHAR2

Table 7–11 Copy_Quote IN Parameters

Parameter Data Type

P_Api_Version_Number      NUMBER

P_Init_Msg_List                   VARCHAR2

P_Commit                            VARCHAR2 

P_Validation_Level    NUMBER 

P_Qte_Header_Id NUMBER

P_Last_Update_Date DATE

P_Copy_Only_Header VARCHAR2 

P_New_Version VARCHAR2 

P_Qte_Status_Id NUMBER

P_Qte_Number NUMBER

Table 7–10 Update_Quote (overloaded) OUT Parameters

Parameter Data Type
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B.2.6 Copy_Quote (overloaded)
Copy_Quote API overloaded with Sales Credit and Quote Party input.

Accepts a new input parameter p_control_rec.

If p_control_rec.COPY_TASK_FLAG is set to ’Y’, then Copy_Quote will copy the 
task associated with quote header.

If p_control_rec.COPY_NOTES_FLAG is set to ’Y’, then Copy_Quote will copy the 
notes associated with quote header.

If p_control_rec.COPY_ATT_FLAG is set to ’Y’, then Copy_Quote will copy the 
attachments associated with quote header.

Copy_Quote expects the user to pass the p_control_rec if they want to copy notes, 
tasks or attachments associated with quote header.

Parameter Descriptions
The following table describes the IN parameters associated with this API.

Table 7–12 Copy_Quote OUT Parameters

Parameter Data Type

X_Qte_Header_Id NUMBER

X_Return_Status                    VARCHAR2

X_Msg_Count                       NUMBER

X_Msg_Data                         VARCHAR2

Table 7–13 Copy_Quote (overloaded) IN Parameters

Parameter Data Type

P_Api_Version_Number      NUMBER

P_Init_Msg_List                   VARCHAR2

P_Commit                            VARCHAR2 

P_Validation_Level    NUMBER 

P_Qte_Header_Id NUMBER

P_Last_Update_Date DATE

P_Copy_Only_Header VARCHAR2 
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The following table describes the OUT parameters associated with this API.

B.2.7 Submit_Quote
The Submit_Quote API converts a quote into an order. 

Before booking an order, Submit_Quote performs credit card authorization (If the 
profile option ASO: Credit Card Authorization is set) and Renewal of a Contract.

Submit_Quote calls the Create Order API to book an order in Oracle Order 
Management.

B.3 Package ASO_ORDER_INT
The following is a list of Oracle Order Capture Foundation APIs in the package 
ASO_ORDER_INT. These APIs are provided for application developers to create 
and update orders in Oracle Order Management. They internally call Oracle Order 
Management APIs and map data to the OM schema.

� Create_Order

� Update_Order

P_New_Version VARCHAR2 

P_Qte_Status_Id NUMBER

P_Qte_Number NUMBER

P_control_rec ASO_QUOTE_PUB.Control_rec_type

Table 7–14 Copy_Quote (overloaded) OUT Parameters

Parameter Data Type

X_Qte_Header_Id NUMBER

X_Return_Status                    VARCHAR2

X_Msg_Count                       NUMBER

X_Msg_Data                         VARCHAR2

Table 7–13 Copy_Quote (overloaded) IN Parameters

Parameter Data Type
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B.3.1 Create_Order
The Create_Order API creates a new order in Oracle Order Management. This API 
passes the necessary data to and from Oracle Order Management to create an Order. 
Create_Order API maps the Quote header and line level information to the Order 
header and lines.

If the user is using the Quoting schema, then Submit_Quote API is preferred over 
Create_Order API.

Parameter Descriptions
The following table describes the IN parameters associated with this API.

Table 7–15 Create_Order IN Parameters

Parameter Data Type

P_Api_Version_Number NUMBER,

P_Init_Msg_List VARCHAR2  := FND_API.G_FALSE

P_Commit VARCHAR2  := FND_API.G_FALSE

P_Qte_Rec ASO_QUOTE_PUB.Qte_Header_Rec_Type

P_Header_Payment_Tbl ASO_QUOTE_PUB.Payment_Tbl_Type

P_Header_Price_Adj_Tbl ASO_QUOTE_PUB.Price_Adj_Tbl_Type

P_Header_Price_Attributes_Tbl ASO_QUOTE_PUB.Price_Attributes_Tbl_Type

P_Header_Price_Adj_rltship_Tbl ASO_QUOTE_PUB.Price_Adj_Rltship_Tbl_Type

P_Header_Price_Adj_Attr_Tbl ASO_QUOTE_PUB.Price_Adj_Attr_Tbl_Type

P_Header_Shipment_Tbl ASO_QUOTE_PUB.Shipment_Tbl_Type

P_Header_TAX_DETAIL_Tbl ASO_QUOTE_PUB.TAX_DETAIL_Tbl_Type

P_Header_FREIGHT_CHARGE_
Tbl

ASO_QUOTE_PUB.FREIGHT_CHARGE_Tbl_
Type

P_header_sales_credit_TBL ASO_ORDER_PUB.Sales_credit_tbl_type

P_Qte_Line_Tbl ASO_QUOTE_PUB.Qte_Line_Tbl_Type

P_Qte_Line_Dtl_tbl ASO_QUOTE_PUB.Qte_Line_Dtl_tbl_Type

P_Line_Payment_Tbl ASO_QUOTE_PUB.Payment_Tbl_Type

P_Line_Price_Adj_Tbl ASO_QUOTE_PUB.Price_Adj_Tbl_Type

P_Line_Price_Attributes_Tbl ASO_QUOTE_PUB.Price_Attributes_Tbl_Type
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The following table describes the OUT parameters associated with this API.

B.3.2 Update_Order
The Update_Order API allows for updates to an existing order in Oracle Order 
Management. This API passes information to and from Oracle Order Management. 
It does not validate information. Validation is performed in Oracle Order 
Management’s Process Order API, which is called by Create_Order. For more 
information on the Process Order API, refer to the Oracle Order Management Suite 
APIs and Open Interfaces Manual, Release 11i.

P_Line_Price_Adj_rltship_Tbl ASO_QUOTE_PUB.Price_Adj_Rltship_Tbl_Type

P_Line_Price_Adj_Attr_Tbl ASO_QUOTE_PUB.Price_Adj_Attr_Tbl_Type

P_Line_Shipment_Tbl ASO_QUOTE_PUB.Shipment_Tbl_Type

P_Line_TAX_DETAIL_Tbl ASO_QUOTE_PUB.TAX_DETAIL_Tbl_Type

P_Line_FREIGHT_CHARGE_Tbl ASO_QUOTE_PUB.FREIGHT_CHARGE_Tbl_
Type

P_Line_ATTRIBS_EXT_Tbl ASO_QUOTE_PUB.Line_Attribs_Ext_Tbl_Type

P_Line_Rltship_Tbl ASO_QUOTE_PUB.Line_Rltship_Tbl_Type

P_Line_sales_credit_TBL ASO_ORDER_PUB.Sales_credit_tbl_type

P_Lot_Serial_Tbl ASO_ORDER_PUB.Lot_Serial_Tbl_Type

P_Control_Rec ASO_ORDER_INT.Control_Rec_Type

Table 7–16 Create_Order OUT Parameters

Parameter Data Type

X_Order_Header_Rec ASO_ORDER_INT.Order_Header_Rec_Type,

X_Order_Line_Tbl ASO_ORDER_INT.Order_Line_Tbl_type,

X_Return_Status VARCHAR2,

X_Msg_Count NUMBER,

X_Msg_Data VARCHAR2

Table 7–15 Create_Order IN Parameters

Parameter Data Type
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Update_Order does not modify quote and relates directly to an order. Any IDs 
passed should relate to the IDs in OM and not quote related IDs.

Parameter Descriptions
The following table describes the IN parameters associated with this API.

Table 7–17 Update_Order IN Parameters

Parameter Data Type

P_Api_Version_Number NUMBER,

P_Init_Msg_List VARCHAR2  := FND_API.G_FALSE

P_Commit VARCHAR2  := FND_API.G_FALSE

P_Qte_Rec ASO_QUOTE_PUB.Qte_Header_Rec_Type

P_Header_Payment_Tbl ASO_QUOTE_PUB.Payment_Tbl_Type

P_Header_Price_Adj_Tbl ASO_QUOTE_PUB.Price_Adj_Tbl_Type

P_Header_Price_Attributes_Tbl ASO_QUOTE_PUB.Price_Attributes_Tbl_
Type

P_Header_Price_Adj_rltship_Tbl ASO_QUOTE_PUB.Price_Adj_Rltship_Tbl_
Type

P_Header_Price_Adj_Attr_Tbl ASO_QUOTE_PUB.Price_Adj_Attr_Tbl_
Type

P_Header_Shipment_Tbl ASO_QUOTE_PUB.Shipment_Tbl_Type

P_Header_TAX_DETAIL_Tbl ASO_QUOTE_PUB.TAX_DETAIL_Tbl_Type

P_Header_FREIGHT_CHARGE_
Tbl

ASO_QUOTE_PUB.FREIGHT_CHARGE_
Tbl_Type

P_header_sales_credit_Tbl ASO_ORDER_PUB.Sales_credit_tbl_type

P_Qte_Line_Tbl ASO_QUOTE_PUB.Qte_Line_Tbl_Type

P_Qte_Line_Dtl_tbl ASO_QUOTE_PUB.Qte_Line_Dtl_tbl_Type

P_Line_Payment_Tbl ASO_QUOTE_PUB.Payment_Tbl_Type

P_Line_Price_Adj_Tbl ASO_QUOTE_PUB.Price_Adj_Tbl_Type

P_Line_Price_Attributes_Tbl ASO_QUOTE_PUB.Price_Attributes_Tbl_
Type

P_Line_Price_Adj_rltship_Tbl ASO_QUOTE_PUB.Price_Adj_Rltship_Tbl_
Type
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The following table describes the OUT parameters associated with this API.

P_Line_Price_Adj_Attr_Tbl ASO_QUOTE_PUB.Price_Adj_Attr_Tbl_
Type

P_Line_Shipment_Tbl ASO_QUOTE_PUB.Shipment_Tbl_Type

P_Line_TAX_DETAIL_Tbl ASO_QUOTE_PUB.TAX_DETAIL_Tbl_Type

P_Line_FREIGHT_CHARGE_Tbl ASO_QUOTE_PUB.FREIGHT_CHARGE_
Tbl_Type

P_Line_ATTRIBS_EXT_Tbl ASO_QUOTE_PUB.Line_Attribs_Ext_Tbl_
Type

P_Line_Rltship_Tbl ASO_QUOTE_PUB.Line_Rltship_Tbl_Type

P_Line_sales_credit_TBL ASO_ORDER_PUB.Sales_credit_tbl_type

P_Lot_Serial_Tbl ASO_ORDER_PUB.Lot_Serial_Tbl_Type

P_Control_Rec ASO_ORDER_INT.Control_Rec_Type

X_Order_Header_Rec ASO_ORDER_INT.Order_Header_Rec_
Type,

Table 7–18 Update_Order OUT Parameters

Parameter Data Type

X_Order_Header_Rec ASO_ORDER_INT.Order_Header_Rec_Type,

X_Order_Line_Tbl ASO_ORDER_INT.Order_Line_Tbl_type,

X_Return_Status VARCHAR2,

X_Msg_Count NUMBER,

X_Msg_Data VARCHAR2

Table 7–17 Update_Order IN Parameters

Parameter Data Type
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C
Pricing and Qualifier Attributes

This chapter contains information on the pricing and qualifier attributes supported 
by Oracle Quoting.

� Overview of Attributes

� Attributes Supported by Quoting
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C.1 Overview of Attributes
Attributes are used to create criteria for the Pricing Qualifiers you set up in Oracle 
Pricing. For example, you can use the Customer Name attribute to create Pricing 
Qualifiers that limits available Promotions based upon the Customer Name.

For more information on attributes in Oracle Pricing, refer to the Oracle Pricing 
User’s Guide.

C.2 Attributes Supported by Quoting
The following table lists the Attributes in Oracle Pricing that Quoting supports:

Table C–1 Attributes Supported by Quoting

Context Attribute Name Pricing Level
Pricing or Qualifier 
Attribute

Customer Account Type Line/Header Qualifier

Customer Agreement Name Line/Header Qualifier

Customer Agreement Type Line/Header Qualifier

Customer Bill To Line/Header Qualifier

Customer Customer Class Line/Header Qualifier

Customer Customer Name Line/Header Qualifier

Customer GSA Indicator Line/Header Qualifier

Customer Invoice To Party Site Line/Header Qualifier

Customer Party Id Line/Header Qualifier

Customer Sales Channel Line/Header Qualifier

Customer Ship To Line/Header Qualifier

Customer Ship To Party Site Line/Header Qualifier

Customer Site Use Id Line/Header Qualifier

Item ALL_ITEMS Line Pricing

Item Inventory Item Id Line Pricing

Item Item Category Line Pricing

Item Segment 1 (Key item 
flexfield segments)

Line Pricing
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Item Segment 2 Line Pricing

Item Segment 3 Line Pricing

Item Segment 4 Line Pricing

Item Segment 5 Line Pricing

Item Segment 6 Line Pricing

Item Segment 7 Line Pricing

Item Segment 8 Line Pricing

Item Segment 9 Line Pricing

Item Segment 10 Line Pricing

Item Segment 11 Line Pricing

Item Segment 12 Line Pricing

Item Segment 13 Line Pricing

Item Segment 14 Line Pricing

Item Segment 15 Line Pricing

Item Segment 16 Line Pricing

Item Segment 17 Line Pricing

Item Segment 18 Line Pricing

Item Segment 19 Line Pricing

Item Segment 20 Line Pricing

Line Volume Item Amount Line Pricing

Line Volume Item Quantity Line Pricing

Line Volume Period1 Item 
Quantity

Line Pricing

Line Volume Period2 Item 
Quantity

Line Pricing

Line Volume Period3 Item 
Quantity

Line Pricing

Modlist Price List Line/Header Qualifier

Table C–1 Attributes Supported by Quoting

Context Attribute Name Pricing Level
Pricing or Qualifier 
Attribute



Attributes Supported by Quoting

C-4 Oracle Quoting - Forms Implementation Guide

Modlist Promotion Number Line/Header Qualifier

Order Customer PO Line Qualifier

Order Line Category Line Qualifier

Order Line Type Line Qualifier

Order Order Category Line Qualifier

Order Order Type Line/Header Qualifier

Order Pricing Date Line Qualifier

Order Request Date Line Qualifier

Order Shippable Flag Line Qualifier

Pricing Attributes Model Id Line Pricing

Pricing Attributes Parent List Price Line Pricing

Segment Market Segment Line/Header Qualifier

Segment Target Segment Line/Header Qualifier

Terms Payment Terms Line/Header Qualifier

Terms Shipping Terms Line/Header Qualifier

Territory Territory Line/Header Qualifier

Volume Line Volume Line Qualifier

Volume Line Weight Line Qualifier

Volume Order amount Line Qualifier

Volume Order Amount Header Qualifier

Volume Order Qty Line Qualifier

Table C–1 Attributes Supported by Quoting

Context Attribute Name Pricing Level
Pricing or Qualifier 
Attribute
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Glossary

accepted

A quote status indicating that the quote terms have been accepted by the customer. 

API

An application programming interface (API) is a published interface to accomplish 
a business or scientific function.

application tier

One of the three tiers that make up Internet Computing Architecture. The 
application tier manages Oracle Applications and other tools.Also known as the 
middle tier.  See Internet Computing Architecture.

attributes

Attributes are used to create criteria for the Pricing Qualifiers you set up in Oracle 
Pricing. 

ATP (Availability to Promise)

The quantity of current on-hand stock, outstanding receipts and planned 
production which has not been committed through a reservation or placing 
demand. In Oracle Inventory, you define the types of supply and demand that 
should be included in your ATP calculation.

availability

The percentage or amount of scheduled time that a computing system provides 
application service. See ATP (Availability to Promise).
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bid

A quote status indicating that the quote has been presented to the customer.

bill-to customer

The name and financial account of the customer who will be invoiced for the goods 
or service ordered.

configurable item

A base model item that a user can configure by adding components.

database tier

One of the three tiers that make up Internet Computing Architecture. The database 
tier manages the Oracle8i database. See Internet Computing Architecture.

debugger

Debug messages notify you every time a trigger starts to fire, and Debug Mode 
allows you to dynamically view the execution of your triggers and variables.

descriptive flexfield

A field that your organization can extend to capture extra information not 
otherwise tracked by Oracle applications. A descriptive flexfield appears in your 
window as a single character, unnamed field. Your organization can customize this 
field to capture additional information unique to your business.

desktop tier

One of the three tiers that make up Internet Computing Architecture. The desktop 
tier provides the user interface display. See Internet Computing Architecture.

drafted

A quote status indicating that the quote is in the initial phase.

entered

A quote status indicating that the quote has been successfully submitted as an order 
in Order Management. Orders with this status can be modified in Order 
Management.

GSA (General Services Administration)

A customer classification that indicates the customer is a U.S. government customer. 
For products on the GSA price list, a fixed price must be used, defined on the GSA 
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contract. The items contained on the GSA price list cannot be sold to commercial 
customers for the same or less price than the government price. The price offered to 
the government must be the minimum in the market. 

inactive

A quote status indicating that no further activity is allowed on the quote.

Internet Computing Architecture

A framework for three tiered, distributed computing that supports Oracle 
Applications products. The three tiers are the desktop tier, application tier or middle 
tier, and database tier.

lookup types

A predefined list of values. Each value in a lookup type has an internal and a 
display name.

lost

A quote status indicating that the customer did not accept the quote.

LOV

A list of valid values in a text field, from which the user must choose.

manual discounts

The ability to manually override the list price of an item.

middle tier

See application tier.

modifier

Defines how Oracle Pricing makes adjustments. For example, a modifier can take 
the form of discounts or surcharges. In Oracle Pricing, when you set up modifiers, 
you define the adjustments your customers may receive. You control the application 
of modifiers by the pricing engine by also setting up rules that specify qualifiers 
and attributes governing their use. 

ordered

A quote status indicating that the quote has been successfully submitted as an order 
in Order Management. Orders with this status cannot be modified in Order 
Management.
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order problem

A quote status indicating that there was a problem when attempting to place the 
order.

order reviewed

A quote status indicating that the order has been reviewed by the customer.

qualifier

Qualifiers, which are defined in Pricing, control who receives price adjustments.

QuickCodes

See lookup types.

quote status

The quote status indicates the stage of preparation that a quote is in. Possible quote 
statuses include drafted, bid, accepted, entered, ordered, order problem, order 
reviewed, lost, and inactive.

quote versioning

The quote version, which is part of the quote number, indicates the latest version of 
the quote. If you set up quote versioning for quote statuses, the version increments 
each time you change the status and save the quote.

role

One or more users grouped by a common responsibility or position.

role types

A collection of roles associated with a particular CRM module.

sourcing rule

Sourcing rules are used by Oracle Pricing for binding attribute values for attributes 
that have been defined in a qualifier or pricing context.

trade-in

A trade-in is performed when a customer wants to return an item for credit against 
an order.
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wildcard

A special character within a search parameter that tells the application to search for 
all records that are similar to the search parameter. In Quoting, % is the wildcard 
character. For example, if you enter "order%" as a quote name search parameter, the 
application returns all quotes with names that begin with "order."
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Index
A
adding quote statuses, 5-2
APIs

order, B-2
create order, B-2, B-17
update order, B-2, B-18

quote, B-2
copy quote, B-2, B-14
create quote, B-2, B-3
submit quote, B-2, B-16
update quote, B-2, B-8

APIs, public, B-1
attachments

adding document categories, 5-13
attributes

pricing, C-1
qualifier, C-1

C
customizing

print quote report, 5-11

D
debugging

setting up, 7-2
descriptive flexfields, 5-8

defining, 5-8
designating a printer

for printing quotes, 5-10
document categories, 5-13

F
flexfields

descriptive, 5-8

G
GSA pricing, 5-13

H
hardware requirements, 2-3
HTTP Server, 2-2

I
implementation task sequence, 4-2
implementation verification, 6-2
introduction, 1-1

L
lookup types, 5-3

setting up, 5-3

O
order APIs

create order, B-2, B-17
update order, B-2, B-18

Order Capture Foundation APIs, B-1
Order Feedback Queue, 7-3
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P
pricing

attributes, C-1
GSA, 5-13

print quote
customizing report, 5-11
designating a printer, 5-10
setting up, 5-10

profile options, 5-7
for Configurator integration, A-2
for Contracts Core integration, A-2
for Item ATP integration, A-3
for Item Reservation integration, A-5
for manual discounts, A-6
for Order Feedback, A-6
for order integration, A-7
for OTS integration, A-9
for payments integration, A-10
for Pricing, A-11
for quotes, A-11
for quotes/order integration, A-14
for security, A-15
for tax integration, A-16
for trade-ins, A-18
obsolete, A-19
setting, 5-7

public packages
ASO_ORDER_INT, B-2
ASO_QUOTE_PUB, B-2, B-3

Q
QuickCodes. See lookup types
quote APIs

copy quote, B-2, B-14
copy quote overloaded, B-15
create quote, B-2, B-3
create quote overloaded, B-5
submit quote, B-2, B-16
update quote, B-2, B-8
update quote overloaded, B-10

Quote Status Setup window, 5-2
quote statuses

disabling, 5-2

enabling, 5-2
setting up, 5-2

quote versioning, 5-2

S
setting up

debugging, 7-2
lookup types, 5-3
print quote, 5-10
profile options, 5-7
quote status, 5-2
quote status transitions, 5-2

software requirements, 2-2

T
troubleshooting

setting up debugging, 7-2
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